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General Description   
The MAX98415A/MAX98425A evaluation system (EV 

system) is a fully assembled and tested system that 

evaluates the MAX98415A/MAX98425A stereo Class-D 

audio amplifier. The EV system consists of the 

MAX98415A/MAX98425A Development Board (DEV 

board), Analog Devices’ Audio Interface Board III 

(AUDINT3), and a USB cable. 

It is recommended that the DEV board be evaluated with 

the AUDINT3 board as an EV system. MAX98415A/ 

MAX98425A supports the standard I2S interface, left-

justified, and Time-division multiplexing (TDM) digital 

audio interfaces. 

The AUDINT3 board provides a USB-to-PCM interface in 

addition to 1.8V AVDD and DVDD supplies needed to 

evaluate the DEV board. Note that if the AUDINT3 is not 

used, AVDD and DVDD can be supplied externally or by 

an on-board LDO with a few 0Ω resistor changes. The 

MAX98415A/MAX98425A DEV board requires two 
additional supply inputs, 2.4V to 5.5V (VBAT) and 3V to 

22V (PVDD). Figure 1 and Figure 2 shows the DEV board 

and the AUDINT3 board. 

Features and Benefits 

• Fully Assembled and Tested  

• EV System provides a Stand-Alone Evaluation Solution 

• Mono or Stereo Operation on a Single Board 

• Multiple EV Systems can be connected to Evaluate a 

Multi-channel Audio Solution 

• Extensive Connection Points and Test Posts 

• Designed-In Amplifier Output Filter Options 

 

MAX984X5A EV System Software  

FILE DESCRIPTION 

MAX984X5EVSwSetupV1_0_0_1.exe 

Installs the EV 

system files onto the 

computer. 

 

Ordering Information appears at end of datasheet 

 

 

 

Figure 1. MAX98415A/MAX98425A EV System Photo 
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Figure 2. Isometric View of MAX98415A/MAX98425A EV System 

 

Quick Start 

Required Equipment 

• MAX98415A/MAX98425A EV System 

o MAX98415A/MAX98425A Development Board (DEV board) 

o Audio Interface Board III (AUDINT3 board) 

o Micro-USB Cable 

• DC Power Supply (2.1V to 5.5V, 1A) 

• DC Power Supply (3V to 22V, 5A) 

• 4Ω or 8Ω Speaker (typical) 

• PC with Windows® 10 (or similar) with available USB port 

• USB audio source (e.g., Windows Media Player® or iTunes®) 

Reference Material 

• MAX98415A/MAX98425A IC Datasheet 

Note: In the following sections, software-related items are identified by bolding. Text in bold refers to items directly from 

the EV system software. Text in bold and underlined refers to items from the Windows operating system. 

Procedure 

The EV system is fully assembled and tested. Therefore, it is operational out of the box. Use the following steps to install 

the MAX984X5A EV system software, make hardware connections, and start using the EV system. The evaluation 

software can be run without hardware attached.  

Note: After the communication is established, the MAX98415A/MAX98425A device must still be configured correctly for 

the desired operation mode. Ensure that the PC is connected to the internet throughout the process so that the USB 

driver can be automatically installed. 
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1) Visit https://www.analog.com/en/products/max98415a.html under the Design & Development tab to download the 

latest version of the MAX984X5A EV system software. Save the software to a temporary folder and unpack the zip 

file. 

2) Install the EV system software by running the MAX984X5EVSwSetupV1_0_0_1.exe program inside the temporary 

folder. This copies the program files and creates an icon in the Windows Start menu. The software requires the .NET 

Framework 4.5 or later. If connected to the internet, Windows automatically updates the .NET Framework as needed. 

3) The EV system software launches automatically after installation. It can be launched by clicking on its icon in the 

Windows Start menu. 

  

AUDINT3 Board Setup 

1) Connect the MAX98415A/MAX98425A DEV board (3-row J1 connector) to the AUDINT3 board (3-row J1 connector). 

To avoid damage, it is important to make sure the connectors of the two boards are properly aligned. The bottom row 

of both J1 connectors should be lined up so that the standoffs on the corners of the AUDINT3 and DEV board are 

level. 

2) With the audio source disabled, connect the included Micro-USB cable from your computer to the USB port (J2) on 

the AUDINT3 board. The AUDINT3 board will provide the BCLK and LRCLK signals automatically upon power-up, 

and the power for AVDD and DVDD, sourcing 1.8V to the DEV board through the J1 connector. 

3) The multi-color LED D1 initially flashes blue, and then should change to slow flashing magenta when the computer 

successfully registers the AUDINT3 as a USB audio playback device. 

  

DEV Board Setup 

1) Place the RESET jumper J3 to DVDD.  

2) Load a default configuration file through the MAX984X5A EV system software (File→Load Register Settings→ 

Pre-installed Configuration Files). A Stereo configuration is available for MAX98415A and MAX98425A in I2S 

format using a 48kHz sample rate. The default files select +24dB gain for a 22V maximum PVDD voltage. 

3) Connect a speaker or a dummy load. Connect the load leads, one to FOUTP and one to FOUTN binding posts. 

4) Connect VBAT. If a DC power supply is not enabled, connect 2.4V to 5.5V power supply at the VBAT and GND 

binding posts. 

5) Connect PVDD. If a DC power supply is not enabled, connect 3V to 22V power supply at the PVDD and GND binding 

posts. 

  

USB Audio Playback Test 

1) Configure the PVDD power supply to 20V and enable the supply. 

2) Configure the VBAT power supply to 3.3V and enable the supply. 

3) Open the Windows Sound dialog and select the Playback tab. A Speakers item, such as Figure 3, should be listed 

as an available playback device. 

4) Verify that the Speakers item is set as the default device. Once this is done, the AUDINT3 board will output PCM 

data to the DIN pin on the DEV board. 

5) Adjust the audio source volume to a low level. 

6) Enable the audio source and verify that audio is heard through a connected speaker or that signal is present on a 

load, if a speaker is not used. Adjust the audio source volume as needed. 

7) Quick Start for USB Audio Playback is now complete. 

8) For details on connecting in a stand-alone mode to audio test equipment, such as Audio Precision, see the Detailed 

Description of Hardware section. 

 

Figure 3. Windows Audio Playback Device 

https://www.analog.com/en/index.html
https://www.analog.com/en/products/max98415a.html


Evaluation Board User Guide MAX98415A/MAX98425A 
  

 

analog.com  Rev 3 4 of 24 

 

Detailed Description of Hardware 
This MAX98415A/MAX98425A evaluation system should be used with the following documents:  

• MAX98415A/MAX98425A Datasheet  

• MAX98415A/MAX98425A Evaluation Board User Guide (this document) 

These documents, or links to them, are included in the MAX98415A/MAX98425A EV system Package. For the latest 

versions of the documents listed above, use the following link: https://www.analog.com/en/products/max98415a.html. 

The MAX98415A/MAX98425A EV system is designed to allow for a thorough evaluation of a MAX98415A or MAX98425A 

digital input Class-D stereo audio amplifier IC. The EV system includes the MAX98415A/MAX98425A Development Board 

(DEV board), the Audio Interface Board III (AUDINT3), and a Micro-USB cable. 

To simplify evaluation, the MAX98415A/MAX98425A DEV board can be used together with the AUDINT3 board and two 

external power supplies for PVDD and VBAT. The AUDINT3 supplies 1.8V for AVDD and DVDD. It also provides a plug-

and-play USB-to-I2S interface, allowing any computer to become a 48kHz digital audio source. The AUDINT3 board 

provides a fast and easy-to-use method for exercising the main capabilities of the device with no additional audio 

equipment. 

The AUDINT3 board automatically detects the MAX98415A/MAX98425A DEV board and configures its LDO regulators 

to power the MAX98415A/MAX98425A DEV board AVDD and DVDD through connector J1. The USB-to-PCM converter 

accepts a USB audio stream from a USB-connected computer and converts it to an I2S stream, allowing for USB audio 

playback through the MAX98415A/MAX98425A device. The AUDINT3 board should not be used to deliver audio input 

when directly driving the DEV board's PCM interface with external audio test equipment. The Digital Audio Interface (DAI) 

pins on the DEV Board, and AUDINT3 digital audio outputs are connected through the J1 header, creating a signal conflict. 

Disable all DAI signals using the AUDINT3 software if using external audio stimuli. However, the AUDINT3 can still provide 

AVDD and DVDD if an external power supply is not available. 

For maximum flexibility, the MAX98415A/MAX98425A DEV board can also be evaluated as a stand-alone board, with 

two external power supplies (PVDD and VBAT). A digital audio signal is then driven directly by specialized audio test 

equipment (Audio Precision, etc.). AVDD and DVDD supplies can be supplied externally or by using an onboard Low 

drop-out (LDO) regulator, U2 (located on the bottom side of the DEV board). To enable the regulator and supply 1.8V to 

AVDD and DVDD, one must populate R33, R34, and R35 with 0Ω resistors. 

Power Supplies 

When evaluated as a stand-alone board, the MAX98415A/MAX98425A DEV board requires two external power supplies: 

PVDD, which is the supply voltage for the Class-D power stage, and VBAT, which supplies low-level system power to the 

IC.  

The power supplies and their ranges are listed in Table 1. The external supply voltages can be connected at the respective 

supply test points and/or binding posts. 

The AUDINT3 board, when properly connected to the DEV Board, senses and automatically provides 1.8V to AVDD and 

DVDD of the MAX98415A/MAX98425A DEV board through jumper J1, when active USB power is supplied.  

Note: Although the AUDINT3 board provides AVDD and DVDD, PVDD and VBAT must still be supplied from external 

sources. 

Table 1. Power Supplies 

POWER SUPPLY RANGE (V) 

VBAT 2.4–5.5 

PVDD 3–22 

AVDD 1.71–1.89 

DVDD 1.71–1.89 

https://www.analog.com/en/index.html
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Jumper Selection 

Shutdown Mode 

The MAX98415A/MAX98425A device features an ultra-low power hardware shutdown mode (controlled by RESET) that 

is activated by connecting the jumper at 3x1-pin header J3 to the GND position. This is the lowest power state, where all 

device registers are returned to their Power-on-Reset (PoR) values, and the I2C control interface is disabled. To exit the 

hardware shutdown, place jumper J3 in the DVDD position and initialize the device. See Table 2 for jumper options. 

Mute 

The DEV Board includes a 3x1-pin header J2 for MUTE. MAX98415A/MAX98425A outputs are muted by connecting 

jumper J2 to the GND position. To unmute, connect jumper J2 to the DVDD position. 

GPIO 

The DEV board includes three GPIO 5-pin headers used to route one of four digital IO: IRQ, ICC, ET_OUT, or DOUT. By 

default, these do not have jumpers. When selecting one of the digital IO, the jumper must be connected from the center 

pin to the digital IO pin (indicated by the silkscreen label on the PCB). In addition, these digital IOs must be manually 

selected in the EV system software inside the “GPIO” block. 

Table 2. Jumper Selection Guide 

JUMPER DEFAULT CONNECTION FEATURE 

J2 DVDD MUTE 

J3 DVDD RESET 

J8 SCL Side (0x70) I2C1 and I2C2 Assignment Pins 

J9 SDA Side (0x70) I2C1 and I2C2 Assignment Pins 

J11 DVDD (0x70) I2C Address Selector 

J12 Open GPIO1 Output (Programmed through GUI) 

J13 Open GPIO2 Output (Programmed through GUI) 

J14 Open GPIO3 Output (Programmed through GUI) 

 

ADDR 

ADDR, a 5-pin header selector (J11), determines the MAX98415A/MAX98425A I2C address. Depending on the I2C1/I2C2 

and ADDR pin selections, there are eight possible addresses. See Table 3 for more details. 

I2C1/I2C2 

The I2C1/I2C2 pins on 3x1-pin headers J8 and J9 can be connected to SDA or SCL. One pin should be connected to 

SCL, and the other pin should be connected to SDA.  

Table 3. I2C Addressing 
I2C1 I2C2 ADDR I2C ADDR 

SCL SDA DVDD 0x70 

SCL SDA GND 0x72 

SCL SDA SDA 0x74 

SCL SDA SCL 0x76 

SDA SCL DVDD 0x78 

SDA SCL GND 0x7A 

SDA SCL SDA 0x7C 

SDA SCL SCL 0x7E 
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Connectors 

I2C1 and I2C2 

2x2-pin header J6 provides the signal outputs of I2C1 and I2C2 for probing purposes.  

Inter-Chip Communication (ICC) 

2x1-pin header J7 provides a probing point and multi-board connection node for the ICC signal. This pin should be 

connected to other DEV boards in a multi-board ICC configuration. 

Envelope Tracker 

2x1-pin header J10 is the connection node available for the feedback pin of an external boost converter when it is desired 

to test the MAX98415A/MAX98425A envelope tracking feature. ET_OUT, which is the MAX98415A/MAX98425A PWM 

output determined by envelope tracking settings, is routed from a selected GPIO pin through filter components, arriving 

at header J10. 

There are three filter options (not populated) on the DEV board: R31, R32, and C26. These are 0402 footprints. 

DAI Header 

The Digital Audio Interface (DAI) consists of 4x2-pin header J4 and (optionally) 2x1-pin header J5. They provide access 
to the MAX98415A/MAX98425A audio input bus: BCLK, LRCLK, DIN, and VDDIO (J5) and audio output: DOUT. The DAI 

header facilitates evaluation using audio equipment I/O. See Table 4 for the pinout of the DAI header. Note that VDDIO = 

DVDD and may be used to set the level of external equipment if needed. 

Table 4. DAI Headers J4 and J5 

JUMPER PIN SIGNAL PIN SIGNAL 

J4 1 GND 2 BCLK 

J4 3 GND 4 LRCLK 

J4 5 GND 6 DIN 

J4 7 GND 8 DOUT 

J5 1 GND  2 VDDIO (DVDD) 

 

Amplifier Outputs 

MAX98415A/MAX98425A amplifier outputs are routed to FOUTP and FOUTN binding posts, one pair for each amplifier 

A and B. The DEV board is, by default, assembled to allow the MAX98415A/MAX98425A outputs to connect directly to a 

speaker load without the need for on-board filter components. 

EMI Filter 

When long speaker cables are used with the MAX98415A/MAX98425A output, such as those exceeding ≈12 inches 

(30.5cm), a ferrite bead plus a capacitor filter can be installed to prevent excessive EMI radiation. Although it is best to 

choose filter components based on EMI test results, the combination of 330pF capacitors C14–C17 and ferrite beads 

FB1–FB4 generally works well. Before adding the filters to the design, the PCB traces shorting the pads of FB1–FB4 must 

be cut (see the MAX98415A/MAX98425A DEV Board Schematic Diagrams and MAX98415A/MAX98425A DEV Board 

PCB Layout Diagrams). Then 0Ω resistors R3, R5, R8, and R10 must be removed. 

Class-D Filter 

Although MAX98415A/MAX98425A has filter-less operation by design, an optional Class-D filter may be installed using 

the SMD footprints of C18–C21 and R11–R14 (not populated) when a commercially available Class-D filter is not 

available. This option is intended for signal observation, such as using an oscilloscope, and is not intended or needed for 

any production solution. Installing this Class-D filter option does not enhance the audio delivered to the speaker in any 

way or provide any other benefits. In fact, there is a corresponding power dissipation when those components are 

installed. 

See the MAX98415A/MAX98425A DEV Board Schematic Diagrams and MAX98415A/MAX98425A DEV Board PCB 

Layout Diagrams for component locations of C18, C19, C20, C21 and R11, R12, R13, and R14. Note that 0Ω resistors 

R4, R6, R7, and R9 must be removed if an LC Class-D filter is installed. 
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Detailed Description of Software 
The MAX984X5A EV system software is designed to be used only with the MAX98415A/MAX98425A EV system. The 

software provides an intuitive graphical user interface (GUI) for programming the device’s I2C registers. It also includes 

an assortment of features intended to aid product evaluation. 

The MAX984X5A EV system software main window (See Figure 4) is composed of four main sections: Menu Bar (File, 

Device, Options, View, Help), Communication Tool Bar (located below Menu Bar), Tabs, and Status Bar (bottom of 

the window). The Menu Bar provides additional features to aid evaluation, the Comm Tool Bar provides basic 

functionality for communicating with the device, and the Status Bar provides information about hardware connectivity 

and communication status. 

The Tabs make up most of the GUI and provide the graphical controls for programming MAX98415A/MAX98425A 

registers, which are displayed on the Block Diagram tab. All device registers can be accessed there by clicking blocks 

and making selections on the corresponding dialog windows. 

The adjacent tab is Control Registers. It provides access to the same registers that are programmable by the Block 

Diagram (ranging from 0x1000 through 0x29FF). However, they are displayed and interacted with in a less graphical 

manner. 

The MAX984X5A EV system software is compatible with Windows 10, or similar versions. It can be downloaded from 

https://www.analog.com/en/products/max98415a.html. Refer to the MAX98415A/MAX98425A IC datasheet for detailed 

device register information.  

 

Figure 4. MAX984X5A EV System Software – Main Window 

 

Communication Tool Bar 

The Communication Tool Bar consists of six buttons and a drop-down combo box. These controls are always 

accessible, regardless of the active tabbed page. The Comm Tool Bar is shown in Figure 5. Table 5 provides details 

about each control. 
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Figure 5. Communication Tool Bar 

 

Table 5. Communication Tool Bar details 

CONTROL FUNCTION 

On Click to set the Global Enable bit (EN). This exits software shutdown and enables the device.  

Off 
Click to clear the Global Enable bit (EN). This enters software shutdown and disables the device. Note: 

The software can communicate with a disabled device because the I2C interface remains active. 

Active Device Provides a list of detected I2C addresses.  The displayed address is the active device. 

Connect/Disconnect 
Connect or disconnect I2C communication from the Active device. See the Hardware and Software 

Connection Sequence section for more details. 

Read All 
Click to read all device registers. The Control Registers and Block Diagram are updated to reflect the 

read data. 

Write All Click to write to all device registers, using the settings selected and displayed in the Control Registers tab. 

Reset Click to reset device registers to their Power-on-Reset (PoR) state. 

 

Hardware and Software Connection Sequence 

When the evaluation software starts for the first time, the program will attempt to automatically connect to the EV system. 

It will first attempt to connect to the USB Control (USB1) interface on the AUDINT3 board. Once that connection is 

established, it will search for all the I2C addresses associated with the MAX98415A/MAX98425A device and populate all 

detected device addresses in the Active Device drop-down list. During this sequence, the text on the Connect To button 

will automatically change from USB to Device to Disconnect, and the status bar will also be updated to reflect the current 

state of the hardware connection. 

Once the EV system is fully connected, the button will display Disconnect, and when clicked, it will disconnect the 

software from the hardware. The software can also be disconnected from the hardware by selecting Options → 

Disconnect from the menu bar. 

There are two methods to re-establish a connection with the hardware. The first is by selecting Options → Auto Connect 

from the Menu Bar. This will instruct the program to automatically connect to the EV system, as done when the software 

first opened. The second method is to manually click the Connect To button until it displays Disconnect, which signifies 

that the EV system is fully connected. 

Status Bar 

The Status Bar is located at the bottom of the software interface. It is divided into three sections. From left to right, the 

sections are Activity, Device Part Number and Revision ID, AUDINT3 Firmware Version, and EV system Status. Note that 

the Revision ID will read 0x42. 

Status Panel 

The Status Panel (not to be confused with the Status Bar) displays the values of the device’s status registers, read from 

registers 0x2001 through 0x204E. 

The leftmost column, under the heading Interrupt Name, is a list of device interrupts. Next to each are circular indicators 

associated with the Raw, State, and Flag interrupt bits. When the indicator is red, it denotes that the associated state bit 

has been set (= 1). The next column to the right, with the header Enable, is a column of checkboxes. Each allows the 

selected interrupt to be mapped to a GPIO1/2/3 block with IRQ selected. The right-most column, with the header Clear, 

consists of a column of buttons. When clicked, that row's State and Flag interrupt bits are cleared (and IRQ is usually 

released). 
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Block Diagram Tab 

The evaluation software uses a graphical block diagram interface to facilitate the programming of the 

MAX98415A/MAX98425A. The block diagram also provides a visual representation of the device’s functions and present 

configuration. For example, MAX98425A does not feature voltage and current reporting; therefore, the associated blocks 

will have a grey border rather than blue. 

The fill color of a diagram block will change to white or blue depending on the active state of the device function(s) 

associated with that block. A disabled block is filled white (with a blue border), while an enabled block is filled blue.  

Figure 6 shows the block diagram with the MAX98415A/MAX98425A configured for DAI (USB audio) input and speaker 

output.  

Grey-filled blocks (such as the TEMP MONITOR) are enabled by default and cannot be disabled. 

Dialog Windows 

Dialog windows are associated with specific blocks in the block diagram, containing controls for configuring the registers 

associated with that functional block. A dialog window is opened by clicking on a dialog block. Figure 7 shows the typical 

GUI controls found on a dialog window.  

 

 

Figure 6. MAX98415A Block Diagram – USB Audio Input to Speaker Output 
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Figure 7. Example of Block Diagram Dialog Window (PCM Block) 

 

Control Registers Tab 

The Control Registers tab provides two methods for configuring the device. See Figure 8 for a screen capture of a 

portion of the Control Registers tab. 

The first configuration method involves clicking a register’s bit name. A grey typeface bit name indicates that the bit is 

currently cleared (= 0). A bold typeface bit name indicates that the bit is currently set (= 1). Clicking on a bit name will 

toggle its logic and write that value to the register. 

The second configuration method involves entering a hexadecimal value into the Hex field, left of bit [7] for a given register, 

and then pressing the PC’s Enter key. The software will automatically configure each bit name in the corresponding 

device register once the Enter key is pressed. The bit name’s typeface will also be updated to reflect the value shown in 

the Hex field. 

All changes made on the Control Registers tab are reflected on the Block Diagram tab and on any open dialog windows. 

Note: Trying to write to a read-only bit, by clicking and toggling its label or entering a hex value in its Hex field will update 

the GUI, but it will not affect the bit’s value in the device. All read-only bits are updated to reflect their current value in the 

device by performing a Read All command. 
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Figure 8. Control Registers Tab 

 

Menu Bar 

All the Menu Bar items are described in Table 6. Additional information for some menu items is provided in the following 

sections. 

Table 6. Menu Bar Options and Descriptions 

MENU BAR OPTION DESCRIPTION 

FILE 

Load Register Settings Loads a configuration file (a default or one saved using Save Register Settings). 

Save Register Settings Saves a configuration file containing the present device settings. 

Exit Closes the MAX984X5A EV system software. 

DEVICE 

Connect Select to have the software automatically connected to the EV system. 

Disconnect Disconnects the PC from the EV system. 

Reset Resets register 0x2000 through 0x29FF to their Power-On-Reset (PoR) states. 

Read All Performs a read from all registers and then updates the GUI. 

Write All 
Performs a write to all writeable registers, using the values shown on the Control Registers tab, and 

then updates the GUI. 

Read Rev ID Reads the Revision ID register and updates the status bar. 

Read Dev ID Reads the Device ID registers, returning either 0x8415 or 0x8425, indicating the device version. 
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MENU BAR OPTION DESCRIPTION 

OPTIONS 

Interface Selection Selects the I2C hardware interface such as AUDINT3. 

Group Write Mode Opens the Group Write feature’s dialog box and available connected device addresses. 

VIEW 

Communication Log 
Shows/hides the command log tab. If checked, the Log tab is displayed to the right of the Control 

Registers tab. 

Search Bar 
Shows/hides the search bar in the Control Registers tab. The search bar allows the user to enter 

registers by name and search the Control Registers space for them. 

HELP 

Release Notes Provides details on where to find help. 

About Provides release information, such as software version for the MAX984X5A EV system software. 

 

Configuration File Loading and Saving 

As described in Table 6, device configuration files are loaded or saved using selections in the File drop-down menu. The 

Save Register Settings option will save the data presently displayed on the Block Diagram and Control Registers tab.  

A configuration file’s main purpose is to capture the present state of the MAX98415A/MAX98425A registers. This makes 

it easy to program a device to a saved and known state, such as stereo or mono modes, and enables sharing of 

configuration files between the users. To facilitate usage, use descriptive file names when saving a configuration file. 

The load and save features are functional even when the hardware is not connected. This allows configuration files to be 

created and opened when hardware is unavailable. Note that because a configuration file is automatically generated by 

the software, it is not meant to be manually formatted. Doing so may cause file-loading errors. To open a configuration 

file for viewing purposes, use a plain text editor. 

Select File → Save Register Settings Ctrl + S to save a configuration file. The register address and its data are saved 

as tab-delimited values, and the file is saved with a .984X5 extension. 

As discussed above, a pre-installed configuration file is available using File → Load Register Settings. Typical 48kHz 

32-bit I2S operation in stereo mode is provided. 

USB Audio Input 

As described earlier, the AUDINT3 (together with a computer) can be used to supply audio over a USB interface. Several 

DAI formats are selectable and can be found under the DAI Mode drop-down menu of the AUDINT3 Interface software 

Audio Controls panel, as shown in Figure 9. The AUDINT3 can also generate test signals of various types, frequencies, 

and amplitudes, as shown in Figure 10. 
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Figure 9. AUDINT3 Configured for Computer Audio Input over USB 
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Figure 10. AUDINT3 Configured for a -12dBFS 1kHz Sine Input using Signal Generator Playback Source 

 

Ordering Information 
    

PART TYPE 

MAX98415AEVSYS# MAX98415A Evaluation System (with Voltage Feedback and Current Monitoring). 

MAX98425AEVSYS# MAX98425A Evaluation System (without Voltage Feedback and Current Monitoring). 

#Denotes RoHS-compliant. 
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MAX98415A/MAX98425A DEV Board Bill of Materials 
 

ITEM QTY REF DES MFG PART # MANUFACTURER DESCRIPTION 

1 2 C1, C2 GRM033R60J105MEA2D Murata Capacitor/1µF/6.3 /20%/ X5R/ 0201 

2 2 C3, C4 GRM155R71H104KE14D Murata Capacitor/100nF/50V/10%/X7R/ 0402 

3 2 C5, C6 GRM21BR61H106KE43L Murata Electronics Capacitor/10µF/50V/10%/X5R/ 0805 

4 1 C7 UCW1H221MNL1GS Nichicon 
Capacitor/220µF/50V/20%/ 

Electrolytic/10mm x 10mm 

5 1 C8 CL03A105MO3NRNH Samsung Capacitor/1µF/16V/20%/X5R/ 0201 

6 4 
C9, C10,  

C11, C12 
GRM033C71C104KE14D Murata Capacitor/100nF/16V/10%/X7S/ 0201 

7 1 C13 GRM188R61A106KE69D Murata Capacitor/10µF/10V/10%/X5R/ 0603 

8 1 C25 CC0402JRNPO9BN180 Yageo Capacitor/18pF/50V/5%/C0G/ 0402 

9 2 C27, C29 LMK105BJ225KV-F Taiyo Yuden Capacitor/2.2µF/10V/10%/X5R/ 0402 

10 1 C28 GCM155R71H103KA55D Murata Capacitor/10nF/50V/10%/X7R/ 0402 

11 1 J1 TSW-113-08-G-T-RA Samtec Updated EVK Daughter Card Header 

12 4 
J2, J3,  

J8, J9 
TSW-103-07-G-S Samtec Header, 3x1 Position, 0.1" Pitch 

13 1 J4 TSW-104-07-G-D Samtec Header, 4x2 Position, 0.1" Pitch 

14 4 
J5, J7,  

J10, J35 
TSW-102-07-G-S Samtec Header, 2x1 Position, 0.1" Pitch 

15 1 J6 TSW-102-07-G-D Samtec Header, 2x2 Position, 0.1" Pitch 

16 4 
J11, J12,  

J13, J14 
22-28-4055 Molex 

Header/0.1" Pitch/Unshrouded/ 5-

pin/Breakaway/Cross Pattern 

17 7 

J15, J19, J20,  

J23, J26,  

J32, J33 

111-2223-001 Johnson Binding Post 

18 12 

J16, J17, J18,  

J21, J22, J24,  

J25, J27, J28,  

J30, J31, J34 

20TCW Not Applicable 
Wire Loop/20AWG/Tinned 

Copper/25mm Length 

19 2 R1, R2 LTR18EZPFSR015 Rohm Resistor/15mOhm/1%/1W/0612 

20 19 

R3, R4, R5,  

R6, R7, R8, R9, 

R10, R17, R18, 

R19, R20, R21, 

R23, R25, R26, 

R28, R36, R37 

RC0402FR-070RL Yageo Resistor / 0Ohm / 1% / 1/16W / 0402 

21 2 R15, R16 RC0402FR-074K7L Yageo Resistor/4.7kOhm/1%/1/16W/0402 

22 1 R24 RC0402FR-0730K9L Yageo Resistor/30.9kOhm/1%/1/16W/0402 

23 1 R27 RC0402FR-0710KL Yageo Resistor/10kOhm/1%/1/16W/0402 

24 2 R29, R30 RR0510P-152-D Susumu 
Resistor/1.5kOhm/0.5%/1/16W/0402/ 

Thin Film 
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ITEM QTY REF DES MFG PART # MANUFACTURER DESCRIPTION 

25 4 
SC1, SC2,  

SC3, SC4 
NY PMS 440 0025 PH 

B&F Fastener 

Supply 

Nylon Screw/4-40 x 1/4"/Phillips/Pan 

Head 

26 4 
ST1, ST2,  

ST3, ST4 
1902C 

Keystone 

Electronics 

Nylon Standoff/4-40 x 1/2"/Female-

Female/ 1/4" Hex 

27 2 TP1, TP2 5010 
Keystone 

Electronics 
Test Point/Multi-Purpose/Red 

28 4 
TP3, TP4,  

TP5, TP6 
5116 

Keystone 

Electronics 
Test Point/Miniature/Green 

29 8 

TP7, TP8, TP11, 

TP17, TP25,  

TP26, TP27, TP28 

5002 
Keystone 

Electronics 
Test Point/Miniature/White 

30 5 
TP9, TP10, TP12, 

TP15, TP16 
5003 

Keystone 

Electronics 
Test Point/Miniature/Orange 

31 2 TP13, TP14 5004 
Keystone 

Electronics 
Test Point/Miniature/Yellow 

32 4 
TP18, TP19,  

TP20, TP24 
5011 

Keystone 

Electronics 
Test Point/Multi-Purpose/Black 

33 3 
TP21, TP22,  

TP23 
5001 

Keystone 

Electronics 
Test Point/Miniature/Black 

34 1 U1 

MAX98415AEWL+ 

or 

MAX98425AEWL+ 

Analog Devices 

22V Digital Input Stereo  

High-Efficiency Class D Amplifier  

with Ultra Low IQ 

35 1 U2 MAX8887EZK18+ Analog Devices 
Low-Dropout, 300mA Linear 

Regulators in SOT23 - 1.8V 

TOTAL 116       

 
  

https://www.analog.com/en/index.html


Evaluation Board User Guide MAX98415A/MAX98425A 
  

 

analog.com  Rev 3 17 of 24 

 

MAX98415A/MAX98425A DEV Board Schematic Diagrams 
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MAX98415A/MAX98425A DEV Board Schematic (Continued) 
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MAX98415A/MAX98425A DEV Board PCB Layout Diagrams  
 

 

MAX98415A/MAX98425A DEV Board—Top Side 

 

 

MAX98415A/MAX98425A DEV Board PCB Layout—Top Silkscreen 

 

 

MAX98415A/MAX98425A DEV Board PCB Layout—Top Layer 
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MAX98415A/MAX98425A DEV Board PCB Layout Diagrams (continued)  
 

 

MAX98415A/MAX98425A DEV Board PCB Layout—Inner Layer 1 

 

 

MAX98415A/MAX98425A DEV Board PCB Layout—Inner Layer 2 

 

 

MAX98415A/MAX98425A DEV Board PCB Layout—Inner Layer 3 
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MAX98415A/MAX98425A DEV Board PCB Layout Diagrams (continued)  
 

 

MAX98415A/MAX98425A DEV Board PCB Layout—Inner Layer 4 

 

 

MAX98415A/MAX98425A DEV Board PCB Layout—Bottom Layer 
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MAX98415A/MAX98425A DEV Board PCB Layout Diagrams (continued) 
 

 

MAX98415A/MAX98425A DEV Board PCB Layout—Bottom Silkscreen 

 

 

MAX98415A/MAX98425A DEV Board—Bottom Side 
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Revision History 
 

REVISION 

NUMBER 

REVISION 

DATE 
DESCRIPTION 

PAGES 

CHANGED 

0 2/25 Initial Release ― 

1 3/25 

Updated Features and Benefits, MAX984X5A EV System Software table, 

Procedure, Configuration File Loading and Saving section, and 

MAX98415A/MAX98425A DEV Board Schematic Diagram 

1, 3, 

7, 12, 17 

2 7/25 
Updated MAX98415A/MAX98425A DEV Board Bill of Materials and 

MAX98415A/MAX98425A DEV Board Schematic Diagram 
15, 16, 18 

3 12/25 Updated MAX98415A/MAX98425A DEV Board Schematic Diagram 17 
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